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REGISTRESANAS

Ludzu, veiciet Sadas darbibas, lai izveidotu Pix4D lietotaja kontu:

1. Uzklikskiniet uz saites vai iekopéjiet to Jusu iecienitaja
parlikprogramma:https://cloud.pix4d.com/signup/
2. Aizpildiet registresanas veidlapu ar informaciju par sevi:

<
pleIS Store Support Settings Licenses Login

Start with a free account

First name
p——— Signup i!.1 a .minutfa and geta
15-day trial including full
access to:
Last name
v Pix4Dmapper desktop
« Pix4D cloud
Email + Personal technical support
Password o

At least 6 characters

Software usage -
Country
Latvia -

The following conditions apply:
* PiedD Cloud Terms Of Service
« Pix4D Privacy Policy

[ Yes, 1 agree with the above conditions

B

CREATE ACCOUNT

3. Spiediet CREATE ACCOUNT.

4. Jums tiks nosutits apstiprinajuma e-pasts, lai varat aktivizet kontu. Atveriet
e-pastu un spiediet Confirm my email.

5. lIrizveidots un apstiprinats Pix4D lietotaja konts.


https://cloud.pix4d.com/signup/

| ICENCES IEGUVE

Ja licence jau nav pierakstita jusu kontam ar e-komercijas pirkumu. Licences
legusana ir nepieciesama, lai nodrosinatu, ka esat savas licences 1pasnieks.
Vispirms parliecinieties, ka Jums ir Pix4D konts. Ja ta nav, izveidojiet to, ka
aprakstits sadala Sign-Up .

Licences ieguSanai veicamas darbibas:

1. Nospiediet uz saites zem Activation Instructions , kas atrodas Licences
sertifikata (License Certificate), kuru sanemat, iegadajoties Pix4D licenci. Vai

ari sekojiet saiknei: https://cloud.pix4d.com/license-redeem/
2. Zemak noraditaja loga ievadiet licences kodu:

Pix40

simply powerful

Redeem Pix4D license / Coupon code

Please introduce the license key you have received in the PDF file or the coupon code on the flyer.

License key / Coupon code

3. Spiediet Redeem; licence ir piesaistita Jusu kontam.


https://cloud.pix4d.com/license-redeem/

DATORAPRIKOJUMS-DATORS

Saja apraksta ir noraditi minimalie un ieteicamie datoraprikojuma un
programmaturas parametri:

MINIMALIE:

Windows 7, 8, 10, Server 2008, Server 2012, 64 biti (PC vai Mac datori, kuros
izmanto utilitprogrammu Boot Camp).

Jebkads centralais procesors (ieteicamie: Intel i5/ i7/ Xeon).

Jebkads grafikas procesors, kas ir savietojams ar OpenGL 3.2. (integrétas
grafikas kartes Intel HD 4000 vai vairak).

Neliela apjoma projektiem (mazak neka 100 attélu ar 14 MP izskirtspeju): 4
GB RAM atmina, cieta diska atminas brivais apjoms.

Vidéja apjoma projektiem (no 100 lidz 500 atteliem ar 14 MP izSkirtspeju): 8
GB RAM atmina, cieta diska atminas brivais apjoms 20 GB.

Liela apjoma projektiem (no 500 lidz 2000 atteliem ar 14 MP izSkirtspéju):16
GB RAM atmina, cieta diska atminas brivais apjoms 40 GB.

Ipasi liela apjoma projektiem (vairak neka 2000 attélu ar 14 MP izSkirtspéju):
16 GB RAM atmina, cieta diska atminas brivais apjoms 80 GB.

IETEICAMIE:

Windows 7, 8, 10 64 biti.

Cetrkodolu vai seskodolu centralais procesors Intel i7/Xeon.

GeForce grafikas karte, kas ir savietojama ar OpenGL 3.2 un 2 GB RAM atminu.
Cietais disks: cietvielu disks.

Nelieliem projektiem (mazak neka 100 attélu ar 14 MP izSkirtspéju): 8 GB RAM
atmina, cietvielu diska atminas brivais apjoms 15 GB.

Vidéja apjoma projektiem (no 100 lidz 500 atteliem ar 14 MP izSkirtspéju): 16
GB RAM atmina, cietvielu diska brivas atminas apjoms 30 GB.

Liela apjoma projektiem (vairak neka 500 attelu ar 14 MP iz8kirtspéju): 32 GB
RAM atmina, cietvielu diska atminas brivais apjoms 60 GB.

Ipasi liela apjoma projektiem (vairak neka 2000 attélu ar 14 MP izSkirtspéju):
64 GB RAM atmina, cietvielu diska atminas brivais apjoms 120 GB.



PROGRAMMATURAS LEJUPIELADE UN
INSTALESANA

Jebkura laika lejupieladei ir pieejamas divas programmaturas versijas:

e Pix4D Desktop: ST versija ir paredzéta apstrades darbiem.
e Pix4D Desktop Preview: Sai versijai ir jaunakas iespéjas, tacu ta nav
paredzeta apstrades darbiem.

LEjuPIELADE
Lai lejupieladetu programmaturu:

1. Dodieties uz: https://cloud.pix4d.com/download/.
2. Lejupieladejiet Pix4D Desktop vai Pix4D Desktop Preview.

INSTALESANA

Kolidz programmatura ir lejupieladéeta, instaléjiet to, veicot sadas darbibas:

1. Veiciet dubultklikski uz lejupieladéta faila. Tiek uzsakta veidne Pix4Dmapper
Setup

2. (Pécizveles): Ja paradas uznirstosais logs Open file - Security Warning,
spiediet Run.

Open File - Security Warning >

The publisher could not be verified. Are you sure that you want to run this
software?

Name: Di\Downloads\PitDmapper.msi
Publisher: Pix4D SA

Type: Windows Installer Package

From: D:h\Downloads'Pixd Dmapper.msi

Run | | Cancel

[] Always ask before opening this file

This file does not have a valid digital signature that verifies its
@ publisher, You should only run software from publishers you trust,
How can | decide what software to run?



https://cloud.pix4d.com/download/

3. Uznirstosaja loga Pix4aDmapper Setup, Welcome to the Pix4Dmapper Setup
Wizard loga spiediet Next >.

4. (Péc izvéles) Spiediet Browse..., lai mainitu instalacijas atrasanas vietu; tad
spiediet Next >.

ﬁ PidDmapper Setup — *

Select Installation Folder |

This is the folder where Pix4Dmapper will be installed. pj-xj,j'l {

To install in this folder, dick "™ext”, To install to a different folder, enter it below or dick

“Browse",
Folder:
IC:‘lPrngram Files\Pix4Dmapper, Browse. ..
Advanced Installer
<Back || mMext> | | Cancel
5. Spiediet Install.
ﬂ PidDmapper Setup >
Ready to Install |
The Setup Wizard is ready to beain the Pix4Dmapper installation pl'.:'{ﬁ':

Click "Install” to begin the installation. If you want to review or chanage any of your
installation settings, dick "Badk”, Click "Cancel” to exit the wizard.

Advanced Installer

<Back || ®Jmstal | | cancel




6. (Péc izvéles) Programmatiras informacijas loga: "Do you want to allow the
following program to install software on this computer?" spiediet Yes.

7. Spiediet Finish.

8. Jusu darbvirsma ir izveidota isinajumikona, un programmatura automatiski
atveras uzreiz péc instalesanas.

9. Pirmoreiz atveroties programmai, paradas logs Pix4Ddesktop Login:

o PidDdesktop Login x

=
Pixa0

&, |Email |
E] |F'asswu:urd |

Login | I forgot my password

Don't have an account? Sion up now

Redeem license key

[P | [ 7]

10. Sadalas Email un Password ierakstiet konta e-pastu un paroli, tad spiediet
Login.
1. Izlasiet noteikumus End-User License Agreement, atziméjiet iespéju | accept
the terms in the License Agreement; spiediet Next
12. .Izvelieties vienu no Sim iespejam:
a. Request PixsDmapper now (Free Trial), ja vélaties aktivizét 15 dienu
izmeéginajuma versiju.
b. Use Pix4Ddiscovery, lai aktivizetu ierobezoto versiju.
c. Choose a license, lal izveletos no konta pieejamajam licencem.
13. Spiediet OK.

Pix4D Desktop ir gatavs darbam.



Valodas iestatijumi

Jus varat nomainit valodas iestatijumus pix4d jebkura bridr:
1. Atveriet Pix4Dmapper.
2. Menu izvelngé, nospiediet Help > Settings...
& PixdDmapper Pro - eagle_RG
Project Process View MapView Help

|I=@ {:} @ lﬁ [ [l Help Contents F1
i Project Proces 5 Online Support
A Forum
[

Home Personal Support

| D:D Settings...
Map View

T About...
a8

3. Settings logs atversies:

B Settings

Proxy Camera Database Language Help Improving the Software

Select the User Interface Language:

English - American English

German (Germany) - Deutsch (Deutschiand)
Spanish (Spain) - espafiol de Espania (Esparia)
French (France) - frangais (France)

Italian (Italy) - italiano (Ttalia)

Japanese (Japan) - B+:E (B*E)

Korean (SouthKorea) - =20 (CHEHDIS)
Russian (Russia) - pycckmid (Pocowa)

Chinese {China) - #E#F5 = (PE)

Chinese (Taiwan) - ¥# I (S

Cancel

4. Uzspiediet uz Language cilnes.
5. lzveleties valodu Select the User Interface Language sekcija.
6. Nospiediet OK.

Izmainas stasies spéka, kad programma ir paladejusies..
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Licences atsaukSana

levieSot programmnodroSinajuma versiju 4.0, tika ieviesta jauna lincenéu vadiba. Ta lauj
atsaukts datora licenci attalinati:
1. lzejiet no Pix4D preogrammas,
2. leejiet License Management paneli: https://cloud.pix4d.com/account/licenses .
3. Pie Pix4Dmapper license, nosiediet Enable now:

30-day online license check @ Disabled
4. leejiet Pix4D Desktop programma. Tas automatiski pieregistrés datoru Llcense
lapa.
5. Lai atsauktu datoru, dodieties lapa : https://cloud.pix4d.com/account/licenses un

@ .

nospiediet Deactivate

ATjAUNINAJUMI

Jaunakas Pix4D Desktop un Pix4D Desktop Preview versijas ir pieejamas
lejupladei, ka aprakstits sadala Lejupielade.

Turklat, ja ir pieejama jauna Pix4D Desktop versija, programmai atveroties,
paradas uznirstosais logs Software Update:

1. Spiediet Download and Install Now, ja vélaties lejupladét un instalét
jaunako pieejamo versiju.

2. Spiediet Remind Me Later ja nevélaties lejupladet vai instalét jaunako
versiju. UznirstoSais logs no jauna paradisies pec 10 dienam.

3. Spiediet Cancel, ja neveélaties lejupladet vai instalét jaunako versiju. Nekads
atgadinajums neparadisies.

[


https://cloud.pix4d.com/account/licenses
https://cloud.pix4d.com/account/licenses

|EVADES DATNES

Galvenie faili, kurus var ievaditPix4Dmapper, ir atteli, kas ir JPEG vai TIFF faili.

BRIDINAJUMS: Neparveidojiet attélus, pieméram, tos nepagrieziet vai
neredigejiet. Izmainas attelos maina kameras geometriskos lielumus un var
samazinat rezultatu kvalitati.

FAILA NOSAUKUMA
OSAUKU APRAKSTS

PAGARINAJUMS

Jpsg, Jpeg JPEG attéli

tif, tiff Monohromatiskie TIFF

Daudzjoslu TIFF (RGB / Infrasarkanie / termalie)

1 slanis (bez piramidas, nav daudzlapu)

8, 10, 12, 14, 16 bit veselais skaitlis, peldosais komats

12



|ZEJAS DATNES

Pix4aDmapper var radit Sadas izejosas datnes:

13

Kameras parametri(lek3&jie parametri, Aréjie parametri, Bingo, SSK): Sie
faili raksturo kameras un attélu iekséjos (fokusa attalums,...) vai aréjos
parametrus (novietojums, orientacija). .

Nekroploti atteli

Blivais punktu makonis (.las, .laz, .xyz, .ply): Tas ir 3D punktu kopums, kas
rekonstrue modeli. Katram blivo punktu makona punktam tiek uzglabats X, Y,
Z novietojums un informacija par krasu.

Digitalais virsmas modelis(Grid DSM, Raster DSM): Tas ir kartétas teritorijas
2,5 dimensiju modelis, kas satur (X,Y,Z) informaciju, bet ne krasas
informaciju.

Digitalais apvidus modelis(DTM: Raster DTM): Tas kartétas teritorijas 2,5
dimensiju modelis péc objektu, piemeram, eku filtrésanas. Tas satur (X,Y,Z)
informaciju, bet ne krasu informaciju.

Orthomozaika(GeoTIFF, KML file, Google Maps HTML faili): 2D modelis
(karte), kas ieguts, savienojot vairakus ortoattélus. leviests krasu balanss, lai
padaritu attélu vizuali patikamu.

Raditaju karte(GeoTIFF, krasu KML fails , Grid Shapefile): Katram raditajam ir
noteikta raditaju karte. Katra Sis kartes piksela vertiba tiek atvasinata no
atbilstoSajam atstarosanas kartem.

3D tekstiras tikls(.obj, .fbx, .dxf, .ply, .pdf, .osgb, .slpk): Tas ir modela
formas atveidojums, kas sastav no virsotnem, sturiem, galiem un teksturas
no atteliem, kas uz ta tiek projiceti. Tas ir noderigs riks, lai atainotu un
vizualizetu modeli, to kopigotu un augSupladetu tiessaistes platformas,
piemeram, Sketchfab.

Kontirlinijas(shp, .pdf, .dxf): Tas ir linijas, kas savieno vienada augstuma
esosus punktus. Tas ir noderigas tapec, ka sniedz iespéju labak izprast
zemes virsmas formu karté (topografiju).

Video animacija (.mp4, .mky, .avi)

3D digitalizéti objekti: polilinijas, virsma, apjomvirsma (.shp, .dxf,.kml, .dgn)


https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label1
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label11
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label12
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#labe212
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#labe213
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label21
https://support.pix4d.com/hc/en-us/articles/206455096
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label31
https://support.pix4d.com/hc/en-us/articles/206455096
https://support.pix4d.com/hc/en-us/articles/206455096
https://support.pix4d.com/hc/en-us/articles/206455096
https://support.pix4d.com/hc/en-us/articles/206799503
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label41
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label42
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label4
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label4
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label4
https://support.pix4d.com/hc/en-us/articles/217263226
https://support.pix4d.com/hc/en-us/articles/217263226
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label43
https://support.pix4d.com/hc/en-us/articles/202558869
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label51
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label52
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label53
https://support.pix4d.com/hc/en-us/articles/206455146
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label91
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label101
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label92
https://support.pix4d.com/hc/en-us/articles/206455116
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label6
https://support.pix4d.com/hc/en-us/articles/202559879
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label_10
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label_11
https://support.pix4d.com/hc/en-us/articles/202558499-Using-Pix4Dmapper-Output-Files-with-Other-Software-By-Output#label_12

ATTELA IEGUSANAS PLANS

Attela iegusanas plans ir atkarigs no:

Rekonstruejamas teritorijas / objekta veida
Zemes parauga attaluma (GSD): projekta specifikacijai nepiecieSamais GSD
attalums nosaka attalumu (lidojuma augstumu), kada jatiek uznemtiem
attéliem. Piemeram, ja GSD ir 5 cm, tas nozime, ka viens attéla pikselis lineari
uz zemes ataino 5 cm (5*5 = 25 kvadratcentimetrus).

e Parklasanas: Parklasanas ir atkariga no kartéjama apvidus veida un nosaka
atrumu, kada ir jauznem atteli.

Sliktas kvalitates attela iegusanas plans radis neprecizus rezultatus vai
apstrades kludu, tapec attelus bus nepiecieSams uznemt atkartoti.

Visi zemak aprakstitie lidojuma plani var tikt palaisti automatiski, izmantojot
lidojuma planoSanas aplikaciju Pix4Dcapture, kas ir pieejama Android un iOS.

PAMATA GADIjUMI

Vairuma gadijumu ir ieteicams attélus ieglt, izmantojot parasto rezga rakstu.
leteicamais parklajums ir vismaz 75% priekséjais parklajums (nemot vera
lidojuma virzienu) un vismaz 60% sanu parklajums (starp lidojuma linijam).
Kamera pari apvidum/objektam ir jatur maksimali nemainiga augstuma, lai
nodrosinatu velamo GSD attalumu.
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Parklajums un lidojuma augstums ir japieskano apvidum.

Meza apvidiem, blivam augu platibam un plakaniem apvidiem ar
lauksaimniecibas laukiem ir ieteicams paaugstinat parklajumu lidz vismaz 85%
prieksejam parklajumam un vismaz lidz 70% sanu parklajumam; tapat ari butu
jalido augstak, lai ir vienkarsak noteikt lidzibas starp atteliem, kas parklajas.
Termalo attelu projektiem ir nepieciesams vismaz 90% prieksejais un sanu
parklajums.

Vairaku lidojumu projektiem vajadzétu bit parklajumam starp dazadiem
lidojumiem un apstakliem (saules virzienu, laikapstakliem, jaunu éku neesamiba
utml) vajadzétu bat lidzigiem.

EKu REKONSTRUESANA

Ekas rekonstuésanai tiek ieteikts cirkularais lidojuma plans.

Pirmoreiz lidojiet ap éku ar kameras lenki 45°.
Otro un tresoreiz lidojot ap eku, palieliniet lidojuma augstumu un ar katru
rinki samaziniet kameras lenki.

e Lainodrosinatu parklajumu, ir ieteicams uznemt vienu attélu ik pa 5-10
gradiem atkariba no objekta izméra un attaluma. Isakiem attalumiem un
lielakiem objektiem vajadzétu uznemt vairak attélu.

15



Piezime: Lidojuma augstumu starp lidojumiem nevajadzetu paaugstinat vairak
par 2 reizem, jo atskirigs augstums rada atskirigu GSD.

16



PILSETAS REKONSTRUESANA — REDZAMAS FASADES

Pilsétteritoriju trisdimensiju attéla rekonstruésanai ir nepiecieSams dubultrezga
attéla ieguves plans, lai visas eku fasades (Ziemelu, Rietumu, Dienvidu un
Austrumu) batu redzamas attélos. Parklajumam bdtu jabut tadam pasam, ka
aprakstits sadala Pamata gadijums.

height 2

height 1

Lai fasades butu redzamas, atteliem ir jabut uznemtiem lenki, kas ir no 10@ lidz
359.
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APSTRADES IESPEJU VEIDNES

Sis ir nokluséjuma apstrades iespéju veidnes (Processing Options Templates),
kas ir pieejamas Pix4aDmapper. Meés Jums tas noteikti iesakam Jusu projektu
apstradei.

APSTRADES IESPEJU

VEIDNE APRAKSTS

3D Maps Izejas datnes: 3D karte (punktu makonis, 3D tekstlras
tikls), ka ari DSM un ortomozaika

Tipiskas ievades datnes: gaisa fotouznemumi, kas ieguti,
izmantojot rezgveida lidojuma planu.

Izejas failu kvalitate/ uzticamiba: augsta
Apstrades atrums: Léns

Pielietojums: karjeri, kadastrs u.c

18


https://support.pix4d.com/hc/en-us/articles/205319155-Processing-Options-Default-Templates#label1

3D Models Izejas datnes: 3D modelis (punktu makonis, 3D tekstlras
tikls)

Tipiskas ievades datnes: slips gaisa attéls vai sauszemes
attéls ar lielu parklajumu.

Izejas failu kvalitate/ uzticamiba: augsta
Apstrades atrums: lens

Pielietojums: éku, objektu, zemes attélu un iekstelpu
attéelu 3D modeli, parbaudes u.c.

Ag Multispectral Izejas datnes: atpogulojuma, raditaju (pieméram, NDVI),
klasifikaciju un aplikaciju kartes.

Tipiskas ievades datnes: "nadir" gaisa fotouznemumi,
kas veikti ar multispektru kameram (Sequoia, Micasense
RedEdge, Multispec 4C, u.c.).

Izejas failu kvalitate/ uzticamiba: augsta
Apstrades atrums: éns

Pielietojums: preciza lauksaimnieciba

Ag Modified Camera Izejas faili: atspogulojuma, raditaju (pieméram, NDVI),
klasifikaciju un aplikaciju kartes

Tipiskas ievades datnes: "nadir" gaisa fotouznemumi,
kas veikti ar parveidotam RGB kameram

Izejas failu kvalitate/ uzticamiba: augsta
Apstrades atrums: léns
Pielietojums: preciza lauksaimnieciba

Ag RGB Izejas datne: ortomozaika

Tipiskas ievades datnes: attéli no RGB, izmantoti
lauksaimnieciba (Sequoia RGB)

Izejas failu kvalitate/uzticamiba: augsta

Apstrades atrums: videjs
19
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3D Maps - Rapid/Low
Res

3D Models -
Rapid/Low Res

Ag Modified Camera
-Rapid/Low Res

Ag RGB - Rapid/Low
Res

Thermal Camera

ThermoMAP Camera
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lauksaimnieciba

Atraka veidnes 3D Maps apstrade iegltas datu kopas
kvalitates novertésanai

Izejas failu kvalitate / uzticamiba: zema
Apstrades atrums: atrs

Atraka veidnes 3D Models apstrade, lai noteiktu iegitas
datu kopas kvalitati.

Izejas failu kvalitate / uzticamiba: zema
Apstrades atrums: atrs

Atraka veidnes Ag Modified Camera apstrade, lai
novertetu iegutas datu kopas kvalitati.

Izejas failu kvalitate / uzticamiba: zema

Apstrades atrums: atrs.

Atraka veidnes Ag RGB apstrade iegiitas datu kopas
kvalitates novertesanai.

Izejas datu kvalitate / uzticamiba: zema
Apstrades atrums: atrs.
Izejas datne: siltuma atstaroSanas karte

Tipiskas ievades datnes: (Tau 2 tipa: FLIR Vue Pro, FLIR
XT).

Izejas datnu kvalitate / uzticamiba:
Apstrades atrums: lens.

Pielietojums: irigacijas kontrole, saules paneli, eku
parbaude etc.

Izejas datne: siltuma atstaroSanas karte


https://support.pix4d.com/hc/en-us/articles/205319155-Processing-Options-Default-Templates#label6
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Tipiskas ievadnes datnes: "nadir" attéli, kas uznemti ar
thermoMAP kameru.

Izejas datnes kvalitate / uzticamiba: augsta.

Apstrades atrums: leéns



KA 1ZVEIDOT PROJEKTU

Saja sadala ir soli pa solim aprakstits jauna projekta izveides process.
Paraugattélu datu kopas var lejupladéet Pix4D zinasanu baze.

JAUNA PROJEKTA IZVEIDE
Lai izveidotu jaunu projektu:

1. Uzsaciet programmu Pix4Dmapper.
2. lzvelné (Menu) nospiediet Project > New Project...

¥ PidDmapper Pro
Project Process  View Help

3 Mew Project... Ctrl+N
[0 Open Project... Ctrl+0
Recent Projects k

Close Project

&% Download Project Files...
Upload Project Files...

& |mage Properties Editor...
4F GCP/MTP Manager..,
i Select Output Coordinate Systemn...

2 Save Project Ctrl+5
Save Project As... Ctrl+Shift+5
Split into Subprojects...

Exit Ctrl+ 0
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3. Tiek atverta jauna projekta veidne:

' New Project X
il

This wizard creates a new project.
Choose a name, a directory location and a type for your new project.

Name: | |

Create In: |C:ﬂ || Browse... |

[] use as Default Project Location

Project Type
@ Mew Project
(O Project Merged from Existing Projects

 Hep | [T=eak | [Thexts | [ cancel |

4. Sadala Name: ierakstiet projekta nosaukumu.

5. (Péec izvéles) Sadala Create in: spiediet Browse... Uznirsto$aja loga Select
Project Location atrodiet un izvélieties mapi, kura atradisies projekts un
ta rezultati; tad spiediet Select Folder.

BRIDINAJUMS: Parliecinieties, ka:

Projekta nosaukums NESATUR 1pasas rakstu zimes.
Projekta atrasanas vietas nosaukums NESATUR ipasas rakstu zimes.
Projekta nosaukums un atrasanas vietas nosaukums kopa satur ne vairak ka
128 rakstu zimes.

6. (Pécizvéles) Atzimejiet lodzinu Use As Default Project Location, ja vélaties
izvéletaja mape saglabat visus jaunos projektus.

7. Sadala Project Type, atstajiet atzimetu nokluseto iespéju New Project.

8. Spiediet Next.
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ATTELU IMPORTESANA

Loga Select Images:

1.

Spiediet Add Images..., lai pievienotu attelus.
B Mew Project X
Select Images
° Enough images are selected: press Next to proceed.
Oimage(s) selected.  |Add Images...| Add Directories...| |Add Video... | Remove Selected | Clear List
x> |

2. Uznirstosaja loga Select Images atrodiet un izvéelieties mapi, kura atrodas
attéli, izvélieties importéjamos attélus (ir iespéjams izvéléties vairakus) un
spiediet Open.

3. Spiediet Next.

ATTELA REKVIZITU KONFIGURESANA
Pirms spiezat Next, ir 3 darbibas, kuras varat veikt pec savas izvéles:

a. (Pécizveles) Izvelieties attéla koordinatu sistému

Ja attéla geolokacija ir noradita koordinatu sistéema, kas nav WGS84
(standarta), spiediet Edit...zem Coordinate System un izvélieties savu
attelu koordinatu sistemu.

b. (Péc izveles, ieteicams) Importet attéla geolokaciju un orientaciju

Ja attéla geolokacija (novietojums) atrodas attélu EXIF lauka, tas tiks
ieladets automatiski. Piezime: geolokaciju var ari importéet no faila,
nospiezot From File....
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Piezime:

e Programmatura izmanto EXIF faila uznemsanas datumu, lai
lestatitu secibu, kada tiek uznemti atteli.

e Pirmais solis - "Sakotnéja apstrade (Initial Processing) ir atraks
projektiem ar attela geolokaciju. Nepietiekama parklajuma
gadijuma attéla geolokacija palidz kalibrét attelus.

c. (Péec izvéles) Redigét izvéleto kameras modeli

Lai programma Pix4Dmapper uzsaktu projektu, ir jabut definétam
kameras modelim. Si modela parametri ir atkarigi no attéla iegisanai
izmantotas kameras. Vairums kameru savu nosaukumu ieglaba attela
EXIF formata metadatos. Tas ir paredzets, lai saistitu noteiktu kameras
modeli ar visiem Sis kameras uznemtajiem atteliem.

Sadala Selected Camera Model, loga Image Properties tiek attelots
izvéletais kameras modelis. Tas var bat:

(V] Derigs: Zals simbols tiek attélots, ja kameras modelis ir derigs. Tas ir
tada gadijuma, ja tas jau pastav Pix4aDmapper kameru modelu
datubaze vai ja attelu EXIF datos ir pietiekami daudz informacijas, lai
izveidotu jaunu kameras modeli, kas tiks ieglabats lietotaja kameru
modelu datubazé. Ja kameras modelis tiek ieguts no EXIF datiem, ir
ieteicams parbaudit kameras modela parametrus un, ja nepieciesams,
tos rediget.

@ lerigs:Sarkans krusts tiek attélots, ja kameras modelis nav derigs.
Kameras moderis ir nederigs, ja neatrodas Pix4aDmapper kameru
modelu datubazé un ja attelu EXIF datos par to nav pietiekami daudz
informacijas. Sada gadijuma kameras modelis ir jadefiné manuali.

Izejas /| GCP KOORDINATU SISTEMAS IZVELE
Loga Select Output Coordinate System:

1. (Péc izvéles) Mainiet Output / GCP Coordinate System.

Piezime:

e [zejas un GCP koordinatu sistemas pec nokluséjuma bus vienadas. Tapéc
izejas datnes var tikt uzraditas GCP koordinatu sistema.
e Nokluséjuma mérvieniba (Unit) ir m(metri).
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Ja attelu geolokacija ir péc nokluséjuma, tiek izveléta iespéeja Auto detected,
kas ataino atteliem atbilstoso UTM vai NAD83 zonu.

Ja attéliem nav geolokacijas, pec nokluséjuma tiek izveléta koordinatu sistema
Arbitrary Coordinate System.

Spiediet Next.

' New Project >
Select Output Coordinate System

Selected Coordinate System

Datum: World Geodetic System 1984
w7  Coordinate System: WGS 84 f UTM zone 32N (egm96)

Output/GCP Coordinate System

Unit: [m ¥

() Arbitrary Coordinate System [m]

(®) Auto Detected:  WGSS84 / UTM zone 32N

() Known Coordinate System [m]

Q

[ advanced Coordinate Options

| Hep <Back [ MNext> || Cancel




APSTRADES IESPEJU VEIDNES IZVELE

Loga Processing Options Template :

1. lzvelieties velamo veidni, pamatojoties uz vélamo pielietojumu un izejas
datnem ka aprakstits sadala Apstrades iespéju veidnes.

B New Project *
dl

Processing Options Template

B 3D Maps DM
aps

E 3D Models P
B Ag Multispectral Generate a DSM and an orthomosaic for mapping applications.
B AgModified Camera
S AgRGB Image Acquisition
& 3D Maps - Rapid/Low Res ||@ nadir flight  oblique flight
& 30 Models - Rapid/Low Res
B AgModified Camera - Rapid/Low Res Outputs Quality/Reliability
2 AgRCE: kapdlowkes [@ e————————
& Thermal Camera Low High

=
& ThermoMAP Camera

@ Processing Speed
‘ | ——
a Slow Fast

Input Image Recommendations

@ Aerial images acquired using a grid flight plan with high overlap, mostly
oriented towards the ground.

Outputs Generated
Crthomosaic

3D Mesh Foint Cloud

Application Examples

« Measure volumes

« Digitize houses and roads
« Generate contour lines

« Google Maps

|:| Start Processing Mow

[ hep | [ <pak | [ Fmsn || cancel |

2. (pécizveles) Izvelieties logu Start Processing Now , lai automatiski uzsaktu
apstradi.
3. Spiediet Finish , lai pabeigtu veidni un uzsaktu projektu.
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APSTRADES DARBIBAS

Saja sadala ir aprakstitas tris darbibas apstradei ar Pix4Dmapper.

SAKOTNEJA APSTRADE

Saja soli attéli un papildu ievades datnes, pieméram GCP, kas aprakstiti sadala
levades datnes, tiek izmantotas sadu uzdevumu veiksanai:

e Atslegpunktu iegiisana: Noteiktas 1pasibas tiek identificétas ka atslegpunkti
attelos.

e Atslegpunktu saskanosana: Tiek atrasti un saskanoti atteli ar vienadiem
atslegpunktiem.

e Kameras modela optimizacija: Kameras iek$€jo (fokusa attalums,.) un aréjo
parametru (orientacija) kalibrésana.

e Geolokacija GPS/GCP: Nosaka modeli, ja ir sniegta informacija par
geolokaciju.

Sis darbibas laika tiek raditi automatiskie sasaistes punkti. Tie ir pamata

nakamajiem apstrades soliem.

Lai iegltu vairak informacijas par izejas datnem, lasiet sadalu Izejas datnes.
PunkTU MAKONI UN TIKLI
Saja darbiba tiek izveidoti automatiskie sasaistes punkti, izmantojot:

e Punktu sablivesanu: Papildu sasaistes punkti tiek izveidoti, pamatojoties uz
automatiskajiem sasaistes punktiem, no kuriem tiek izveidots sablivetais
punktu makonis.

e 3D teksturas tikls: uz sablivéta punktu makona bazes var radit 3D teksturas
tiklu.

DIGITALAIS VIRSMAS MODELIS, ORTOMOZAIKA, RADITAJS
Saja darbiba var radit:

e Digitalo virsmas modeli (DSM): DSM izveide sniedz iespéju izstradat
apjomus, ortomozarkas un atstaro3anas kartes.
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e Ortomozaika: Ortomozaika tiek radita ar laboSanas metodi. Si metode no
atteliem nonem potencialos kroplojumus.

e Atspogulojuma karte: Mérkis ir radit karti, kura katra piksela vertiba precizi
norada objekta atspogulosanos.

e Raditaju karte: Izveidojiet raditaju karti, kura katra piksela krasa tiek
aprekinata, izmantojot formulu, kura tiek apvienotas dazadas atspogulojuma

kartes(-Su) joslas.

29



ZEMES KONTROLPUNKTI (GCP)

Si metode tiek izmantota, kad attéla geolokacija un zemes kontrolpunkti ir
zinama koordinatu sistéma, ko var izvéléties no Pix4Dmapper koordinatu
sistemu datubazes. Sim abam sistémam nav jabut vienadam jo programma
Pix4Dmapper var veikt konvertaciju starp divam zinamam koordinatu sistemam.

Sis ir visizplatitakais gadijums un padara iespéjamu zemes kontrolpunktu
atzimesanu uz atteliem ar nelielu manualu iejauksanos. Tomer SI metode nav
piemerota "nakts" apstradei, kuras laika atskirigi apstrades soli automatiski tiek
uzsakti viens pec otra un kuru izpildei nav nepiecieSama lietotaja uzraudziba.

NoORADES

1. Lauka vai citviet iegusties zemes kontrolpunktu lielumus.

2. Pievienojiet / importéjiet zemes kontrolpuntus, izmantojot GCP / MTP
Manager , tos NEATZIMEJOT.

3. lzvélnes sadala spiediet View > Processing. Josla Processing paradas
Galvena loga apaksa

4. Izvelieties 1. Initial Processing un 2. Point Cloud and Mesh un 3. DSM,
Orthomosaic and Index.

5. Spiediet Start.

P Processng (1. (Jz2 O3 | 1 of8 Start

.....

6. Kolidz ir pabeigta sakotnéja apstrade (Initial Processing) ,sadala rayCloud
atziméjiet zemes kontrolpunktus. Labaja sanjosla, sadala Layers, spiediet Tie
Points, tad GCPs / MTPs. Tiek paradits zemes kontrolpunktu saraksts.
Izvelieties zemes kontrolpunktu sadala GCPs / MTPs: labaja sanjosla tiek
paraditi ta rekviziti un to attelu saraksts, kuros tas ir redzams. Atzimejiet
precizu zemes kontrolpunkta atrasanos uz vismaz 2 attéliem, izmantojot
peles kreiso klikski. Kad zalais krusts ir pareizaja vieta vairuma attelu,
spiediet Apply.

7. Spiediet Process > Reoptimize.

(Péc izvéles) Atjaunojiet kvalitates zinojumu, spiezot Process > Generate

Quality Report.
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